SmartLabs HouseLinc™
Desktop

INSTEON PC Automation Software
#2416
V 1.01-181

Requires:
#2414U USB PLC or #2414S Serial PLC
# HOUSELINC DESKTOP OWNER’S MANUAL

## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTRODUCTION</td>
<td>4</td>
</tr>
<tr>
<td>Computer Requirements</td>
<td>4</td>
</tr>
<tr>
<td>What is INSTEON?</td>
<td>4</td>
</tr>
<tr>
<td>HOW TO INSTALL HOUSELINC DESKTOP</td>
<td>5</td>
</tr>
<tr>
<td>SOFTWARE OVERVIEW</td>
<td>6</td>
</tr>
<tr>
<td>DEVICE NETWORK SETUP</td>
<td>8</td>
</tr>
<tr>
<td>Devices</td>
<td>8</td>
</tr>
<tr>
<td>Opening a New Network File</td>
<td>8</td>
</tr>
<tr>
<td>Important Notes Regarding Auto Link</td>
<td>10</td>
</tr>
<tr>
<td>Adding New INSTEON Devices Manually</td>
<td>11</td>
</tr>
<tr>
<td>Adding an X10 Device</td>
<td>11</td>
</tr>
<tr>
<td>Adding Devices by “Spidering”</td>
<td>11</td>
</tr>
<tr>
<td>Rediscovering Devices</td>
<td>13</td>
</tr>
<tr>
<td>Important Notes Regarding Rediscovering Devices</td>
<td>13</td>
</tr>
<tr>
<td>Naming Your Devices</td>
<td>13</td>
</tr>
<tr>
<td>Device/Button Properties</td>
<td>13</td>
</tr>
<tr>
<td>Miscellaneous Device Configuration</td>
<td>18</td>
</tr>
<tr>
<td>Deleting Links</td>
<td>22</td>
</tr>
<tr>
<td>Saving Your Network Setup</td>
<td>23</td>
</tr>
<tr>
<td>Backing up and Restoring Your HouseLinc Configuration</td>
<td>23</td>
</tr>
<tr>
<td>EVENTS</td>
<td>24</td>
</tr>
<tr>
<td>Setting up an Event</td>
<td>25</td>
</tr>
<tr>
<td>Editing an Existing Event</td>
<td>26</td>
</tr>
<tr>
<td>Copying Events</td>
<td>26</td>
</tr>
<tr>
<td>Testing Events</td>
<td>26</td>
</tr>
<tr>
<td>Enable/Disable Events</td>
<td>26</td>
</tr>
<tr>
<td>Important Notes Regarding Events</td>
<td>27</td>
</tr>
<tr>
<td>TIMERS</td>
<td>28</td>
</tr>
<tr>
<td>Setting up a Timer</td>
<td>29</td>
</tr>
<tr>
<td>Editing an Existing Timer</td>
<td>30</td>
</tr>
<tr>
<td>Testing a Timer</td>
<td>30</td>
</tr>
<tr>
<td>Important Notes Regarding Timers and Events</td>
<td>31</td>
</tr>
<tr>
<td>DIRECT CONTROL</td>
<td>32</td>
</tr>
<tr>
<td>DEVICE PROPERTIES</td>
<td>33</td>
</tr>
<tr>
<td>LOG</td>
<td>34</td>
</tr>
<tr>
<td>OPTIONS</td>
<td>36</td>
</tr>
<tr>
<td>Port setting</td>
<td>36</td>
</tr>
<tr>
<td>State/City</td>
<td>36</td>
</tr>
<tr>
<td>PLC Diagnostics</td>
<td>36</td>
</tr>
<tr>
<td>ABOUT INSTEON</td>
<td>38</td>
</tr>
<tr>
<td>Understanding Why an INSTEON Network Is Reliable</td>
<td>38</td>
</tr>
<tr>
<td>Further Enhancing Reliability</td>
<td>38</td>
</tr>
<tr>
<td>Using Smarthome’s SignaLinc RF to Upgrade Your INSTEON Network</td>
<td>38</td>
</tr>
</tbody>
</table>
INTRODUCTION

HouseLinc Desktop is a powerful Windows application that lets you control your home using INSTEON and X10 devices. With HouseLinc you can program timers to turn lights and appliances on or off, create triggered events that activate when an INSTEON or X10 signal is detected, and help you manage INSTEON links.

The HouseLinc Desktop software uses:

- Your current INSTEON network
- Your INSTEON PowerLinc Controller (PLC) connected to your PC (models #2414U or #2414S)
- Your Microsoft Windows PC

Computer Requirements

HouseLinc Desktop works on any computer running Microsoft Windows 2000 or above.

Minimum requirements:

- 600Mhz CPU or better
- 128MB RAM
- One available port (USB or RS-232) for your PLC

What is INSTEON?

INSTEON is a simple, reliable, and affordable breakthrough in home control. INSTEON uses existing powerline wiring as well as radio-frequency for communication between INSTEON devices. INSTEON is reliable, because every INSTEON device is a two-way repeater. And INSTEON is affordable, not just because of low cost, but because INSTEON also works with legacy X10 devices. An INSTEON home grows in value with every INSTEON device you add, making life more convenient, safe and fun.
HOW TO INSTALL HOUSELINC DESKTOP

If you obtained HouseLinc Desktop on a CDROM, inserting the disc into your CD drive will automatically launch an installation wizard. If you downloaded HouseLinc Desktop via the internet, or the wizard did not automatically launch after inserting the CDROM, browse the CDROM or the download folder, and locate the file named “SetupHouseLinc.exe”. Double-click on this file. A wizard will now guide you through the software installation process. During software installation, you will be prompted to connect your PowerLinc Controller (PLC). Follow these steps to connect your PLC:

1. Plug your INSTEON PowerLinc Controller (PLC) into an AC outlet.
2. Connect your PLC to your computer via the USB or RS232 (serial) cable that came with your PLC. If it is the first time you are installing the PLC, please allow a few minutes for Windows to recognize the new hardware.

The setup program will prompt you to start HouseLinc. If you choose not to start HouseLinc now, you can do so later by double-clicking the HouseLinc Desktop icon on your desktop.

If you are not using a USB version of the PLC, you must now tell HouseLinc which serial port you are using. Please see the Options section for details on setting the serial port.

Enter your registration key.
1. From the Help menu, select Register HouseLinc.
2. In the Registered Key fields, enter the key as it appears on the label on the back of your CD jacket.
3. Click the OK button.

NOTES

- If the LED on the side of the PLC is blinking rapidly, there might be excessive electrical noise in your home electrical system. To reduce this electrical noise, the use of a FilterLinc (http://www.smarthome.com/1626.HTML) is recommended. Failure to use a FilterLinc in a high-noise environment can adversely affect communications between the PLC and the devices you are attempting to control.
- If you have Internet security features enabled on the PC running HouseLinc Desktop, a warning message about the device manager (SDM3.exe) attempting to communicate might appear. If prompted by a popup message, select the options that allow any inbound and outbound communications for the SDM3.exe program.
- If you are having any problems registering your application, please contact your dealer.
SOFTWARE OVERVIEW

The HouseLinc Desktop application is divided into 8 main sections:

- All Known Devices
- Links
- Events
- Timers
- Direct Control
- Properties
- Log
- Options

Contains all your devices in your network.

Contains the devices controlling the focused device.

Tabs: Link, Events, Timers, Direct Control, Properties, Log and Options

Device you are focusing on.

Contains the devices controlled by the focused device.
The All Known Devices window is visible from every section of the HouseLinc Desktop application.

Timers and Events are controlled through the HouseLinc Desktop software directly. In order to run timers and events, the HouseLinc Desktop software must be running on your computer, with an active connection to the PLC. Additionally, HouseLinc Desktop requires at least one device to be configured within the software before it allows the creation of timers and events.

We recommend installing HouseLinc Desktop on a computer that can be left running at all times. If your computer is turned off or goes into suspend or hibernate mode, your timers and events will not be executed until the computer resumes normal operation. To simplify operation, it’s also recommended that you add HouseLinc Desktop to your computer’s startup group, which ensures HouseLinc Desktop is automatically launched every time your PC boots. (Note- If your PC is configured with multiple user accounts, HouseLinc Desktop will only be launched from the account(s) where HouseLinc Desktop is added to the startup group(s), and only after one of those accounts is logged into). The application to add to your startup group is houselinc.exe; the default location is C:\Program Files\SmartLabs\HouseLinc Desktop.
DEVICE NETWORK SETUP

Devices
The All Known Devices pane lists all of the INSTEON and X10 devices found on your network. You can give each device a descriptive name. The All Known Devices pane contains items that you have previously configured, as well as devices that HouseLinc Desktop detected but have not yet been configured.

There are three different categories of INSTEON devices:
• Controller only: these devices can control other devices but cannot be controlled remotely. An example is a ControLinc.
• Responder only: these devices can respond to controllers but cannot control other devices. An example is a LampLinc.
• Controller/Responder: these devices can control other devices and can be controlled remotely. Examples are SwitchLincs and KeypadLincs.

For each device in your network, the All Known Devices pane displays:
• an icon
• the name you have assigned
• the INSTEON ID
• the type of device
• the X10 address, if applicable

Mustard color devices in the device list tree show devices that are unrecognized. They are valid devices but belong to a family of devices not yet defined.

Opening a New Network File
Device, timer and other configuration data is stored in a local configuration file. For new installations:
1. From the Network Menu choose “New”
2. Choose “INSTEON Network”
3. A new blank network file will appear

Once the configuration is created, HouseLinc Desktop will automatically open it whenever the application is launched.

Initial Steps
1. Insert your CD into your computer’s CD-ROM drive. The install wizard should launch automatically, and will guide you through the installation process. If the wizard does not launch automatically, navigate to the CD-ROM and double click the SetupHouseLinc.exe file.
2. Plug your PowerLinc V2 Controller (PLC) into an AC outlet. The LED should flash and then remain steadily on.
3. Connect your PLC to your computer via the USB or RS232 (serial) cable that came with your PLC.
   Note: Please allow a few minutes for Windows to recognize the new hardware.
4. Double-click the HouseLinc Desktop icon on your desktop to start the application.
5. A pop-up registration form will appear. Enter your username, email address and registration key (located on the back of the CD jacket). The status field will change to “registered,” turn green, then disappear. If it does not turn green in a few seconds, check and re-enter your information.
6. Click on the Options tab, then click the drop-down list under Port Setting, choose the appropriate port and click the Set button (if you change the port that was currently set, you'll need to exit HouseLinc Desktop and restart the application for the new port setting to become active). Under PLC Diagnostics click Start to verify the port is correct, then click OK. Please see the manual's troubleshooting section if you receive an error message saying “PLC diagnostics failed.” Next, click the Factory Reset button (this will download coreapp 12 to the PLC, it will not delete any links already in the PLC). If you are using 3rd party software you should check with the manufacturer of the software to verify the software is compatible with coreapp 12. Although the Factory Reset will not erase links already added it will clear all timers downloaded to the PLC if you are using Timer software.

7. Enter your state and then city from the state drop-down lists. Press Apply button. In approximately 5-7 seconds, you will receive a confirmation that the state and city have been set. You are now ready to set up device(s).
Adding Devices Using Auto Link

The easiest way to enroll all of your INSTEON devices into HouseLinc is to use Auto Link. Auto Link will enroll each of your INSTEON devices into the PLC and HouseLinc, and will display them on screen in the order they were enrolled. Each device will display a default name (defaults to the SmartLabs part number and description) and the INSTEON ID. Before beginning the Auto Link process, we recommend you print the “DeviceListWorksheet.pdf” to help keep track of your devices.

1. In the “Network” menu, choose “New” then choose Devices (Autolinking). The Auto Link window will appear and the PLC's LED will begin blinking.
2. Go to an INSTEON device and press-and-hold its button for 10 seconds as if you were creating an INSTEON link from it to another device. The device's LED will blink several times while it enrolls, then the LED should return to its normal state. As the device is recognized by HouseLinc, the device will appear in the Auto Link window and HouseLinc will emit a pair of beeps. NOTE: if the LED on the INSTEON device you are enrolling continues to blink, this indicates that the enrollment process was not successful. In this case, tap the device’s button till it drops out of linking mode and repeat this step.
3. Write down the name and location of the device you just enrolled.
4. Repeat steps 2 and 3 for each INSTEON device in your home (NOTE: wait five (5) seconds after successfully enrolling a device before enrollment of the next device). HouseLinc will listen for new device enrollments for up to 4 minutes from the last device. Each time a new device is enrolled, the 4 minute timer is restarted. Note: PowerLinc Controllers and SignaLinc RF devices should not be enrolled into HouseLinc.
5. After enrolling all of your devices, return to the computer.
6. The Auto Link window will display all of the devices you enrolled in the order you enrolled them. Rename each device in the Auto Link window based on the names and locations you wrote down as you went from device-to-device. We highly recommend making a note of the INSTEON IDs of each device on your worksheet for future reference. If you are unsure about whether a device is the one you think it is, double-click the device to test the device. Each double-click will change the device from ON to OFF or OFF to ON. To rename a device:
   A. click its name once then press <F2> on your keyboard
   B. type the new name
   C. press ENTER.
7. When you have finished entering all of the device names, click the OK button.
8. All of the enrolled devices will now appear in the All Known Devices pane with two question marks (??) in front of their names. The ?? signifies that the devices have been added to HouseLinc but their link databases have not yet been read.
9. Save your work by choosing “Save” from the File menu (you can either Save to file or Save to file As to choose a different filename).

Important Notes Regarding Auto Link

- When enrolling a KeypadLinc or SwitchLinc, you can either press-and-hold the paddle (or button) for 10 seconds or press-and-hold the set button for 3 seconds.
- When enrolling a LampLinc or ApplianceLinc, press-and-hold the set button for 3 seconds.
- When enrolling a ControLinc, press-and-hold button 1 ON for 10 seconds.
- Only INSTEON devices can be enrolled through Auto Link. X10 devices must be created manually.
- Enrolling INSTEON devices through Auto Link will create a link from the INSTEON device to the PLC. If the INSTEON device is a Controller/Responder, it will have a "controller" link; if the INSTEON device is a Responder only, it will have a "responder" link.
- PowerLinc Controllers and SignaLinc RF devices should not be enrolled into HouseLinc.
Adding New INSTEON Devices Manually

1. From the Network Menu, choose “New” then choose “Device.”
2. In the New Device ID window, enter the INSTEON ID of the device being added.
3. Click the “Check to see if the INSTEON device is connected” box.
4. HouseLinc will try to locate that device on your network to determine its type and capabilities.
5. If the device was found and identified, the INSTEON type will be displayed. If not, manually choose the type of device from the dropdown list.
6. Enter a name for the device.
7. To add another INSTEON device, click the "Add Another" button and repeat from step 2.
8. Click the "Next" button.
9. A summary of the device(s) you are adding will appear. Click the "Finish" button.
10. Your new device(s) will appear on the All Known Devices pane.
   Note: they will appear with ‘??’ in front of the name you assigned because their database hasn’t been read yet. Performing a network spider or rediscovering the device will validate your new device.

Adding an X10 Device

To add an X10 device to your network, use the new device wizard.
1. From the Network Menu, choose “New” then choose “Device.”
2. Choose X10
3. Enter the X10 address of your device
4. Enter a name
5. Click “Finish”
6. Your device is now added to the All Known Devices pane.

Note: The X10 device must have its address separately set through manual commands. See the user manual of your X10 device for instructions on setting its address.

Adding Devices by “Spidering”

Spidering is a feature in HouseLinc Desktop for automatic discovery and configuration of INSTEON devices. HouseLinc Desktop will communicate with an INSTEON device and read its internal table of linked devices. HouseLinc Desktop will then communicate with each of those devices contained in the first device’s table, and read each of their link tables. Like a spider traversing its web, HouseLinc Desktop queries each INSTEON device in an outward-radiating fashion, populating device configuration along the way. Because of spidering’s use of the INSTEON link tables, at least one INSTEON device must already be configured (either manually or using the Auto Link method) within HouseLinc Desktop for spidering to work.
To initiate the spidering process:
1. From the Network Menu choose "Discover INSTEON Network." That will start the spidering of your network.

2. Let the spider run. This may take from several seconds to more than an hour depending on the extent of your network. The actual amount of time depends on the number of links in your network, not the number of devices; each link takes approximately 5-10 seconds.

3. During the spidering a progress window will be displayed:
   - The window title indicates an estimate of the percent complete.
   - The Current Device box displays the device being currently pinged.
   - The Current Link Record box displays the link record currently being read.
   - The Statistics box lists the Current Number of Links found so far for the Current Device, the total number of devices found so far and the total number of links found so far for the Current Device.
   - The large area on the right displays the INSTEON traffic.
   - The bottom of the spider window has a progress bar and time estimates for how the spider is progressing. Note: You might see the progress bar to go up or down depending on the number of links found.

Once the spider completes, the progress window will disappear and the All Known Devices list will contain all of the devices that have been discovered (in addition to any that you manually created).
NOTE: If you need to stop the spidering process, click the "Abort" button. The spidering process may take a moment or two to stop. Remember that your network is incomplete at this point. It's highly recommended that you run the spidering process from beginning to end; it is not possible to resume a spider where it left off when it was cancelled. It’s also recommended that you save your existing file prior to spider. If you abort, HouseLinc will revert to that last saved file.

Rediscovering Devices

Rediscovering a device causes HouseLinc to relearn the type of the device, its properties, and its link database. After using Auto Link, devices appear in the Device list but need to be discovered either through a spider or through rediscovery. NOTE: before rediscovering a device we recommend that you confirm that the device exists in your network and is plugged in (or power is applied to wired-in devices).

1. Right-click on the device and choose Re-Discover Device.
2. A progress window will appear, similar to spidering your entire network.
3. Rediscovering a device may take from several seconds to many minutes. The actual amount of time depends on the number of links in the device's link database; each link takes approximately 5-10 seconds.
4. If rediscovery was successful (the device could be contacted and its link database read), the device will appear in the Device list window instead of the Unknown Devices window.

Important Notes Regarding Rediscovering Devices

- When you rediscover a device, HouseLinc will read its link database but NOT follow links to other devices. This can result in HouseLinc finding partial links (links in the rediscovered device without a corresponding link in the database of the linked device).
- If the database of the device cannot be completely read for any reason, the rediscovery of that device will fail and the device will not be considered rediscovered (it will remain an unknown device and/or continue to have ?? in front of its name). This prevents you from having a partial link database for the device. (Creating and/or deleting links if you have only a partial database can cause corruption of the link database.)
- If you need to rediscover multiple devices, you can select them by holding the CTRL key down and selecting all of the devices you want to rediscover. After you have selected all of the devices, right-click and choose Re-Discover Device.

Naming Your Devices

Each device in the All Known Devices list can be given a name to help you identify it. The following sequences will all allow you to name/rename a device:

- Click it once, then press <F2> on your keyboard.
- Click it once, wait a second, then click it once again.
- Right click the device, then select the "rename" option.

When the existing name is highlighted after executing one of the above sequences, you can type in a new name. (Hint – Choose names that are as descriptive as possible, which will make the creation and management of Events, Timers and Links much easier.) Save the name by pressing <ENTER>.

Device/Button Properties

The Device Properties and Button Properties windows give you access to information about a device/button as well as giving you access to direct control and troubleshooting tools.
Access the device or button properties windows by right clicking on a device or button in the All Known Devices pane and selecting “Properties” or by using ALT-P while focusing on a device/button.

**General Tab**

The General tab provides information about a device, such as its name, INSTEON ID, type of device, and firmware revision. Depending on the device, device-specific settings may also be accessible from the General Tab.

You can also rename a device from this tab by typing over the existing name.
Test Device Tab
The Test Device tab allows you to run on/off tests on a device.

The Standard ON/OFF Test will repeatedly turn the device on then off again. The standard test turns the device on then turns it back off approximately one second later.

The Timed ON/OFF Test allows you to specify how often the device should change from on to off and vice versa (Frequency) and how long the test should run (Duration).

To start a test, click the Start Test button. To stop the test, click the Stop Test button.

NOTE: the Test Device tab is only available for devices that are Responders or Controller/Responders. Devices that are controllers only (such as a ControLinc) will not display the Test Device tab.
Advanced Tab

The Advanced tab allows you to look at the link database records for the selected device. You can view either the link database either as records or as links (controller links and responder links).

Note: you cannot change the link database from this window. It is displayed for diagnostic/display purposes only.
**Direct Control Tab**

The Direct Control tab allows you to turn a device on, off, dim, brighten or set to a specific level (if the device allows it).

To control a device, choose the desired level and click the Set button or click one of the specific action buttons (Turn on, Turn off, etc.). Depending on the device, there may also be additional device-specific controls accessible from the Direct Control tab.
Miscellaneous Device Configuration

Deleting a Device
To permanently delete a device from the All Known Devices list, right-click on the device and choose Delete Device. This will delete links to and from other devices as well as remove the item from the All Known Devices list. To complete this operation, you will need to save your changes to the network.

Unknown Devices
In the event that a device could not be contacted during the spidering process but is listed in the link database of another INSTEON device on your network, that device will appear in the Unknown Devices window. Only the INSTEON ID of the device is displayed since the device could not be contacted to identify itself.

Overriding a Device's Type
If the spidering or discovery of a device indicates that it can be contacted and its links read, but the device type cannot be determined, the device will remain in the Unknown Devices window. To specify the device type, right-click the device and choose "Override Device Type" then pick the device type from the list. After you override a device type, you should rediscover the device.

Swapping ID
There may be instances where you need to physically replace a device with an identical. Rather than manually deleting and recreating all the configuration and link information, you can use the Swap ID function. From the All Known Devices list, right click on the device you are replacing and select Swap ID. In the field provided, type in the ID of the new device, which is printed on a label affixed to the side or back of the device. Click on the OK button to save new device ID. To complete the process, “save to network” to propagate device ID changes to other devices in your home.

Saving Devices to Network
The following functions can be time-saving features when making minor modifications to devices:

- “Save Changes to this device to the network…” will only save changes made to the selected device to the network. This can be useful for updating settings on a particular device. Links will only be updated to the device currently being updated; for this reason, new links will not work properly unless you also save to other related devices. It’s also recommended that you “save to file” prior to saving to network, to ensure HouseLinc Desktop retains the latest configuration.
- “Save all links of this device to the network…” will save all information for a selected device to the network. This can be useful for loading information into a particular device that may have been reset, without having to save to the entire network. Links are updated only on the device currently being updated, so new links will not work unless you save to the other related devices as well. It’s also recommended that you “save to file” prior to saving to network, to ensure HouseLinc Desktop retains the latest configuration.

Check Devices for Rediscovery
This option will check to see if any devices on the network are not completely configured. HouseLinc Desktop will highlight any devices that are found to have incomplete configuration information. To work on any of these devices, simply right click on the desired device and select “re-discover” to load all of its information into HouseLinc Desktop.
Links

Every INSTEON device contains a link database that describes how it is linked to other devices; that is, which devices it controls and which devices it responds to. When an INSTEON device is linked to another device, the responding device has a record that tells it what to do (i.e., turn on to 50% with a rate of 0.1 seconds).

To view link information, switch to the Links tab and double-click a device in the All Known Devices list. The device will appear in the INSTEON DEVICE pane (middle-right). We will refer to this device as the “selected device.”

- In the Controllers pane (top-right), each device that controls the selected device will appear. Each controller will indicate which button is used to control the selected device and what the selected device will do when the controller button is pressed (what level and at what rate).
- In the Responders pane (bottom-right), each device that is controlled by the selected device will appear. Each responder will indicate to what level it should go when controlled and at what rate.

Clicking on one of the selected device’s buttons will indicate the Controller and Responder links for just that button.

Clicking on the selected device will indicate all Controller and Responder links for the selected device.

NOTE: A link is typically 2-way i.e. both devices must know about it. A device in red signifies that the link is broken on one side. Rediscovering a device may correct this situation.

To manage the INSTEON links in your network you will need to have a network file open. If you have already created a network and populated it (either by manually adding devices or by spidering) you are ready to manage your INSTEON links. If you do not already have a network file, please see the section on creating a network file and devices in the DEVICES section.
KeypadLinc Device Configuration

HouseLinc Desktop has the capability of configuring several of KeypadLinc’s operating parameters, including 6/8 button mode, local ramp rate, and lock out of local programming using the KeypadLinc buttons. To use HouseLinc Desktop to modify these parameters, access the configuration menu from device properties, and make sure you save changes to network before exiting HouseLinc Desktop. Note: the local ramp rate is the time the load needs to turn on.
KeypadLinc Toggle Mode

HouseLinc Desktop also provides a simple way to enable toggle mode for any buttons on KeypadLinc. Toggle mode provides visual indication of load status (via button LED backlighting). This feature is especially handy when the linked load is in another room than the KeypadLinc, where the device’s state isn’t readily obvious. To enable or disable toggle mode for a KeypadLinc button, open the properties tab for the desired KeypadLinc button and check or clear the toggle checkbox as desired.

Note: Toggle mode allows a button to send alternatively ON and OFF commands while a button in non-toggle mode will only send one command, either ON or OFF. The ON or OFF command will follow the state of the LED when saving to network i.e. if the LED is ON, the button will send ON commands, if the LED if OFF, the button will send OFF commands.
Adding Links

There are 2 ways to create new links: add a Controller link to the selected device or add a Responder link to the selected device.

To make another INSTEON device control the selected device
1. Click once on the selected device’s button that you want to control.
2. Drag a device or button from the All Known Devices window to the Controllers pane. You should see a link appear in the Controllers pane. If the device has multiple buttons, capable of controlling multiple loads, dragging such a device to the Controllers pane will prompt the user to select which button should be linked.
3. Optionally adjust the Level % and the Rate: Click on the level or rate listed for a particular device or button, then press F2 (or click the value, wait one second, then click the value a second time). Choose a new value from the drop-down menu, then press ENTER.

To make another INSTEON device respond to the selected device
1. Click once on the selected device’s button that you want to use to control the other device. If you would like multiple devices to respond, hold the CTRL button down while selecting the desired devices, which will highlight all of your choices.
2. Drag a device or button from the All Known Devices window to the Responders pane. You should see a link appear in the Responders pane.
3. Optionally adjust the Level % and the Rate. This will affect the way the responder device acts when the selected device's button is pressed.

Cross-linking devices
Cross-linking INSTEON devices allows two (or more) devices to control each other, working as a virtual 3-way (or 4-way, etc.) circuit. An example of cross-linked devices is a pair of switches on a staircase: switch #1 at the top of the stairs and switch #2 at the bottom of the stairs. The goal would be to have either switch able to turn the stairway light on or off. To create the links for this example:
1. Double-click switch #1 in the All Known Devices window. Switch #1 becomes the selected device and is displayed in the INSTEON DEVICE pane (middle-right).
2. Click switch #1’s button 1 in the INSTEON DEVICE pane.
3. Drag switch #2's button from the All Known Devices window to the Controllers pane. You should see a link created.
4. Drag switch #2's button from the All Known Devices window to the Responders pane. You should see another link created.
5. Optionally adjust the Level % and the Rate for each link.

Deleting Links

To delete a link, right-click the link you want to delete in the Controllers pane or the Responders pane. Choose Delete Link. The link will turn light-gray, indicating that you have deleted a link but have not saved your change to the INSTEON network. Multiple links can be deleted by holding down the CTRL button while selecting the desired links, then click on Delete Link. Once you have saved your changes to the INSTEON network, the light-gray link will disappear.

Note: When deleting links, be sure to click the link, not the device. Clicking the device and selecting delete will delete the entire device and all of the links to/from it.
Saving Your Network Setup

You have several options for saving changes you've made to links in your INSTEON network.

- Save your INSTEON network to a file
- Save changes to the INSTEON network
- Update your entire INSTEON network

Saving Your INSTEON Network to a File

This option saves your work to a file. Saving your INSTEON network to a file allows you to return your INSTEON network to its current state at a later time. From the File menu, choose Save (to replace the current network file with your updates) or choose Save As (to save to a new file).

Saving Changes to the INSTEON Network

This option saves changes made to your INSTEON network since your last spidering. From the Network menu, choose Save Changes To INSTEON Network. This may take from several seconds to more than an hour depending on the extent of your changes. Each added, changed, or deleted link takes approximately 5-10 seconds to save. A progress window is displayed indicating the estimated time to complete the update. NOTE: it’s recommended that you save your INSTEON network to a file before saving changes to the INSTEON network.

Updating Your Entire INSTEON Network

From the Network menu, choose Save All To INSTEON Network. Your current network file will be downloaded to your INSTEON network. This may take from several seconds to more than an hour depending on the extent of your network and the number of links. Each link takes approximately 5-10 seconds to save. A progress window is displayed indicating the estimated time to complete the update. NOTE: it’s recommended that you save your INSTEON network to a file before updating your entire INSTEON network.

Backing up and Restoring Your HouseLinc Configuration

Your HouseLinc configuration consists of a number of different files: your current INSTEON devices and links file, which is the .SLD file you create/modify/save using Network > New INSTEON Network, Network > Discover INSTEON Network, File > Save, and File > Save As; your timers and events file (events.txt); and your INSTEON ID name resolution file (names.txt).

From time-to-time, you may wish to backup your HouseLinc configuration to preserve specific combinations of devices, timers, and events, such as a seasonal or holiday schedule. This is especially useful if you need to move HouseLinc to a different computer or re-install HouseLinc.

To backup your HouseLinc configuration, choose "Backup…" from the File menu and enter a file name.

To restore your HouseLinc configuration, choose "Restore…" from the File menu and choose a previously saved HouseLinc backup file. To complete the restore of your INSTEON network, you must also save your changes to the INSTEON network (if your devices and links have changed).

Note that restoring a HouseLinc backup will replace your current timers/events and INSTEON devices and links. If you have added or removed devices or modified INSTEON links since you backed up your configuration, you may want to load a recent network (.SLD) file after restoring your backup so that the devices and links more closely represent your current network.
Events are series of actions triggered by receiving an INSTEON or X10 signal from a button-press on your network. When the specified trigger is received, the event is fired.

An example of an event is:

- When MyKeypadLinc Button 1 is pressed, turn MyLight on.

All programmed events are summarized on the Events tab. The 3 columns displayed are:

- When: the trigger for the event
- Conditions (actions): the actions that should occur and any conditions associated with each action
- Results: the last time the actions were fired. If the action has not fired since HouseLinc was started, “n/a” is displayed.

Events can be enabled or disabled by checking/unchecking the box next to the desired event, or by right clicking the event and selecting activate or deactivate. Multiple events can be managed by holding the CTRL key while clicking on the desired events, then right and choose activate or deactivate events.

Event Summary Screen

Selecting the “Show only selected devices” box will show only events associated with devices you previously selected in the All Known Devices pane.
Setting up an Event

There are two parts to creating an event: the trigger and the action(s). The trigger is what causes the event to be run.

Triggers and actions can be set to only operate on specific days of the week (called a day of week condition). The days of the week for the trigger take precedence over the days of the week for the actions so if an action is set to operate every day but the trigger is only set to work on Mondays, the action will only be fired on Mondays. An example of a day of week condition is:

When lamp1 turns off On Monday, Tuesday and Thursday
Turn lamp2 at 50% on Thursday
Wait 30 seconds
Turn lamp2 at 100%

In this example, lamp 2 will only turn on to 50% for 30 seconds on Thursdays but will turn on to 100% on Mondays, Tuesdays and Thursdays.

Events can contain delays; delays cause the event to pause for the specified amount of time before continuing. An example of an event including a delay is:

When lamp1 turns on
Turn lamp2 at 50%
Wait 30 seconds
Turn lamp2 at 100%

Note: for events to fire, your PC must be running and your PLC connected.

Another note: there can be a very small delay between the triggering of the event and the event itself and that is related to the communication between the PC and the PLC.
Set the trigger
1. Navigate to the Events tab.
2. Click the Add Event button. The Events tab changes to the Event editor screen.
3. From the "Which device should trigger these reactions" drop-down, choose the device that should trigger the event.
4. From the "Which button" drop-down, choose which button on the selected device should trigger the event.
5. From the "Which event should trigger" drop-down, choose what action on that button should trigger the event.
6. From the "Which days of the week should these reactions work" drop-down, choose on which day(s) of the week this trigger event should take place.

Configure the action(s)
7. Click the Add Action button.
8. Choose what device should be operated from the "To which device" drop-down. From the "What should happen" drop-down, choose what should happen in this action (turn on, turn off, delay, etc.).
9. In the "For how long" box, you can choose how long this action should last.
   a. If you chose an action in step 8, checking this box and entering a time will cause the action to reverse itself after the duration in the box has elapsed.
   b. If you chose DELAY in step 8, this box specifies how long the delay is.
10. From the "Which days of the week are OK for this action" drop-down, choose the day(s) of the week on which this action should fire.
11. If you want to add more actions, repeat from step 7.

Clicking the OK button will save your changes and take you to the main Event summary. Clicking Test Now will run the actions in this event; HouseLinc will simulate the trigger so it is not necessary to send the trigger.

Editing an Existing Event
To edit an existing event, click once on the event you want to edit, then click the Edit Event button. You will be taken to the Event editor screen. You can now change any aspect of the event: the trigger and/or the action(s). To save your changes, click the OK or Apply button. Clicking the Cancel button will return you to the main Events summary page without saving your changes.

Copying Events
To copy an existing event, click once on the event, then right-click the event and choose Duplicate Event. This will make a copy of the event and open it in the event editor.

Testing Events
To test an existing event (to make sure its actions are programmed correctly), click once on the event, then right-click the event and choose Test Fire Event. This will cause the event to fire as if the trigger had been received.

Enable/Disable Events
Highlight the desired event, then check (or clear) the box next to the event "When" as desired.
Important Notes Regarding Events

- In order for HouseLinc to trigger an event based on a button-press on an INSTEON device, the INSTEON device must already be enrolled in the PLC AND the INSTEON device must have at least 1 "controller" link from that button. Enrolling the INSTEON device using Auto Link takes care of both of these requirements.

- Any KeypadLinc button that is to be used as an event trigger must have a "controller" link to another INSTEON device. You can create a "controller" link from a button directly to the PLC using link management by making the PLC's button 1 a responder to the KeypadLinc's button.
TIMERS

Timers are a special class of events that are triggered at a certain time rather than by an INSTEON or X10 signal. When the time matches the specified trigger time, the event is fired. An example of a timer is: at 6:00pm, turn on the Entry Light.

Note: As for events, your PC must be running and your PLC connected for timers to fire. Another note: there can be a very small delay between the time of the timer and the actual timer and that is related to the communication between the PC and the PLC.

All programmed timers are summarized on the Timers tab. The 4 columns displayed are:
- At: the time trigger for the event
- Conditions (actions): the actions that should occur and any conditions associated with each action
- Results: the last time the actions were fired. If the action has not fired since HouseLinc was started, “n/a” is displayed.
- Next Alarm At: the next time the timer will fire.
Setting up a Timer

There are two parts to creating a timer: the trigger and the action(s). The trigger is what causes the event to be run.

Timers can contain delays; delays cause the timer to pause for the specified amount of time before continuing. An example of a timer including a delay is:

- At 2:30pm
  - Turn lamp2 at 50%
  - Wait 30 seconds
  - Turn lamp2 at 100%

Set the trigger

1. Navigate to the Timers tab.
2. Click the Add Timer button. The Timers tab changes to the Timer editor screen.
3. From the "When should this timer occur" drop-down, choose whether this timer runs at a specific time, at sunrise or at sunset.
   a. If you choose a specific time, enter the time next to "At."
   b. If you choose at sunrise or sunset, you can optionally specify an offset from sunrise or sunset by entering the amount of time to offset by in the "Offset" box and choosing Before or After from the "From sunrise/sunset" drop-down.
4. If you would like to randomize the time by +/- 15 minutes, check the "Vary the time daily" box. This makes the timer look less like a timer and more like a person is actually operating the device(s); this can be helpful if you are going on vacation and want to make your house look "lived-in" while you're away.
5. From the "Which days of the week should these reactions work" drop-down, choose on which day(s) of the week this trigger event should take place.

Configure the action(s)

6. Click the Add Action button.
7. Choose what device should be operated from the "To which device" drop-down. From the "What should happen" drop-down, choose what should happen in this action (turn on, turn off, delay, etc.).
8. In the "For how long" box, you can choose how long this action should last.
   a. If you chose an action in step 7, checking this box and entering a time will cause the action to reverse itself after the duration in the box has elapsed.
   b. If you chose DELAY in step 7, this box specifies how long the delay is.
9. From the "Which days of the week are OK for this action" drop-down, choose the day(s) of the week on which this action should fire.
10. If you want to add more actions, repeat from step 6.

Clicking the OK button will save your changes and take you to the main Timer summary. Clicking Test Now will run the actions in this timer; the trigger is simulated by HouseLinc so it is not necessary to wait for the trigger time.

Enable/Disable Timers

Highlight the desired timer, then check (or clear) the box next to timer schedule.
Editing an Existing Timer

To edit an existing timer, click once on the timer you want to edit, then click the Edit Timer button. You will be taken to the Timer editor screen, just like when you created the timer initially. You can now change any aspect of the timer: the trigger and/or the action(s). To save your changes, click the OK or Apply button. Clicking the Cancel button will return you to the main Timers summary page without saving your changes.

Testing a Timer

To test an existing timer (to make sure its actions are programmed correctly), click once on the timer, then right-click the timer and choose Test Fire Timer. This will cause the timer to fire as if the trigger time had been reached.
Important Notes Regarding Timers and Events

- The Results column will change from "n/a" to "OK (fired)" or "Verified" when an action is activated; the date/time of the action will also be included in the Results column. "OK" represents HouseLinc sending a command to the device. "Verified" represents HouseLinc sending a command and receiving an acknowledgement that the command was received. Failure to see "Verified" does not necessarily mean that the action did not occur, just that no acknowledgement was received.
- Every time you edit a timer or an event, the Results columns are cleared in both the Timers and Events tabs as the new schedule is read.
- Timers are automatically sorted by time.
- Events are automatically sorted by the trigger device/button.
DIRECT CONTROL

The Direct Control tab allows you to control your devices manually, in real time. You can turn them on or off or set them to specific levels (if supported by the device). The Direct Control window also contains a log window that shows all control signals sent by HouseLinc Desktop to the device.

NOTE: you can only control devices that are Responders or Controller/Responders.

To control a device:
1. Click once on a device in the All Known Device List.
2. HouseLinc will query the device for its current status and display it. If the device’s status may have changed since opening the Direct Control tab, press the Get Status button to query the current status.
3. Choose what you want to do from the drop-down list, or choose the “turn on”, “turn off”, “dim” or “bright” buttons.
4. Device specific controls may not be displayed on the main Direct Control tab. Click on the More Properties tab, and some additional controls for the device may be available for use.
5. Click the Set To button.
DEVICE PROPERTIES

The Properties tab allows you to rename a device and to associate an X10 address to a device in your device list.

NOTE: It is not possible to SET the X10 address of an INSTEON device through this software. Please refer to the instruction manual for your INSTEON device to set the X10 address on it.

To rename a device:
1. Click a device in the All Known Device list.
2. In the Device Name box, type the name you want to assign to this device.
3. Click the Apply button.

To associate an X10 address to an INSTEON device:
1. Click a device in the All Known Device list.
2. In the X10 Address box, enter the X10 address to associate with this device.
3. Click the Apply button.
4. The X10 address will be visible in the X10 column in the All Known Device list.
The Log tab contains a running log of all control signals sent by HouseLinc Desktop to the devices in your All Known Device list. To view the portions of this log that apply to specific devices, use the Direct Control tab.

There are 2 log views: Simple and Advanced.

- Simple – shows textual descriptions of device activity. This log is most helpful for confirming that your timers and events are working correctly.
- Advanced – shows raw device traffic. This log is most helpful if you need to contact technical support regarding a device problem.

Sample of Simple Log Window

<table>
<thead>
<tr>
<th>Time</th>
<th>Device Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006-07-27 22:22:56.828</td>
<td>Office Lights (table) (00.00.3E) directly remote controlled to OFF</td>
</tr>
<tr>
<td>2006-07-27 22:22:16.000</td>
<td>TV Room (00.07.19) verified as 10%</td>
</tr>
<tr>
<td>2006-07-27 22:27:17.468</td>
<td>TV Room (00.07.19) verified as 10%</td>
</tr>
<tr>
<td>2006-07-27 22:27:17.703</td>
<td>TV Room (00.07.19) verified as 10%</td>
</tr>
<tr>
<td>2006-07-27 22:27:19.437</td>
<td>Star's Room (00.07.20) verified as OFF</td>
</tr>
<tr>
<td>2006-07-27 22:27:19.921</td>
<td>Star's Room (00.07.20) verified as OFF</td>
</tr>
<tr>
<td>2006-07-27 22:27:20.718</td>
<td>Star's Room (00.07.20) directly remote controlled to ON</td>
</tr>
<tr>
<td>2006-07-27 22:27:24.671</td>
<td>Livingroom Lights (right) (00.07.14) directly remote controlled to ON</td>
</tr>
<tr>
<td>2006-07-27 22:27:26.359</td>
<td>Livingroom Lights (left) (00.0A.39) directly remote controlled to ON</td>
</tr>
<tr>
<td>2006-07-27 22:27:26.453</td>
<td>Livingroom Lights (left) (00.0A.39) directly remote controlled to ON</td>
</tr>
<tr>
<td>2006-07-27 22:27:29.531</td>
<td>Gallery Lights (00.07.22) verified as 25%</td>
</tr>
<tr>
<td>2006-07-27 22:27:30.312</td>
<td>Gallery Lights (00.07.22) directly remote controlled to OFF</td>
</tr>
<tr>
<td>2006-07-27 22:27:31.531</td>
<td>Porch Light (00.07.32) verified as OFF</td>
</tr>
<tr>
<td>2006-07-27 22:27:32.562</td>
<td>Porch Light (00.07.32) directly remote controlled to OFF</td>
</tr>
<tr>
<td>2006-07-27 22:27:33.937</td>
<td>Livingroom Lights (right) (00.07.14) verified as ON</td>
</tr>
<tr>
<td>2006-07-27 22:27:35.000</td>
<td>Livingroom Lights (right) (00.07.14) directly remote controlled to OFF</td>
</tr>
<tr>
<td>2006-07-27 22:27:35.171</td>
<td>Livingroom Lights (right) (00.07.14) directly remote controlled to OFF</td>
</tr>
<tr>
<td>2006-07-27 22:27:36.218</td>
<td>Livingroom Lights (left) (00.0A.39) verified as ON</td>
</tr>
<tr>
<td>2006-07-27 22:27:36.546</td>
<td>Livingroom Lights (left) (00.0A.39) verified as ON</td>
</tr>
<tr>
<td>2006-07-27 22:27:37.234</td>
<td>Livingroom Lights (left) (00.0A.39) directly remote controlled to OFF</td>
</tr>
</tbody>
</table>
### Sample of Advanced Log window

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006-07-27 22:22:56.296</td>
<td>sentinsteonoff=06 69 F8 00 58 3E 05 13 00</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:22:56.890</td>
<td>receiveventsteonoff=04 00 58 3E 06 68 F8 25 13 00</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:22:56.906</td>
<td>eventraw=03</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:27:15.250</td>
<td>sentinsteonoff=00 00 00 00 07 19 05 19 01</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:27:15.765</td>
<td>eventraw=03</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:27:16.033</td>
<td>receiveventsteonoff=04 00 07 19 05 68 F8 21 37 19</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:27:16.703</td>
<td>sentinsteonoff=00 00 00 00 07 13 05 19 01</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:27:17.578</td>
<td>receiveventsteonoff=04 00 07 19 06 68 F8 21 37 19</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:27:17.736</td>
<td>receiveventsteonoff=04 00 07 19 06 68 F8 21 37 19</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:27:18.625</td>
<td>sentinsteonoff=00 00 00 00 07 20 05 19 01</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:27:19.531</td>
<td>receiveventsteonoff=04 00 07 20 06 68 F8 21 05 00</td>
<td></td>
</tr>
<tr>
<td>2006-07-27 22:27:20.062</td>
<td>receiveventsteonoff=04 00 07 20 06 68 F8 25 05 00</td>
<td></td>
</tr>
</tbody>
</table>

Page 35 of 40
OPTIONS

The options tab allows you to set some system parameters such as your city and state and the port being used by the PLC. You can also run advanced PLC diagnostics from this tab.

Port setting

This option allows for setting the communications port used to connect the PLC to the computer.

To set the communications port for the PLC:
1. Choose a COM port (RS232 serial) or USB
2. Click the SET button.
3. Click YES in the confirmation window.
4. It may take several seconds for the port to be set and communications with the PLC to be established. During this time, you may see a message that the PLC is not yet connected or responding. This is normal and should be cleared within 10-20 seconds. It is recommended that HouseLinc Desktop be restarted to make the selected port the new default port for PLC communication.

State/City

The state and city are needed to correctly set the sunrise and sunset times which are used by timers.

To set the state and city:
1. From the State drop-down list, choose your state.
2. From the City drop-down list, choose your city.
3. Press the Enter key.
4. In approximately 5-7 seconds, you should receive a confirmation that the state and city have been set.

PLC Diagnostics

The PLC Diagnostics can help identify and correct problems you may experience with your PLC. The diagnostics test such things as: connectivity to the PLC; that the PLC contains valid software; that the PLC returns its INSTEON ID; the port to which the PLC is connected; the firmware version running in the PLC.

To run the diagnostics:
1. Click the Start button to start pinging the PLC.
2. In approximately 5 seconds, you should receive a pop-up window indicating whether the diagnostic passed or failed. If the PLC diagnostic passed, there is no need to do any further testing.

If the PLC diagnostic fails and the PLC is not responding, try unplugging the communications cable from the PLC, wait 10 seconds, then plug it back in and re-run the PLC diagnostics. If the PLC is still not responding, unplug the PLC from AC power, wait 10 seconds, and plug it back in. Wait 10 seconds then re-run the PLC diagnostics.

If the PLC diagnostic fails and the PLC Software Valid test returns "False" you can correct this by clicking the Factory Reset button. The Factory Reset button will reset the PLC and update the PLC Core App. Updating the Core app can take several minutes during which HouseLinc will not process timers and events.
Options Screen

```
Options Screen

<table>
<thead>
<tr>
<th>Links</th>
<th>Events</th>
<th>Timers</th>
<th>Direct Control</th>
<th>Properties</th>
<th>Log</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Event/Timer Support**

- **Set Sunrise/Sunset**
  - County/State/City
  - Decimal Latitude/Longitude

**Postal Setting**

- **Postal Setting**
  - **USB**

**PLC Diagnostics**

- **PLC Diagnostics**
  - Details:
    - PLC Is Responding: TRUE
    - PLC Software Valid: TRUE
    - GET0240 Response: 00 01 1A 03 02 3D
    - PLC Port: USB
    - PLC Connected: True
    - PLC Firmware: 213
    - PLC ID: 00 01 1A
    - PLC Device Type: InsteonPLC USB
    - PLC Last Error #: 40

**PLC Diagnostics Last Run At:** 11/15/2006 12:21 pm
```
ABOUT INSTEON

Understanding Why an INSTEON Network Is Reliable

INSTEON messages travel throughout the home via Powerline Carrier (PLC) signals on the existing house wiring, and also via wireless Radio Frequency (RF). As the messages make their way to INSTEON devices being controlled, they are picked up and retransmitted by all other INSTEON devices along the way. This method of communicating, called a mesh network, is very reliable because each additional INSTEON device helps to support the overall network.

To further ensure reliability, every INSTEON device confirms that it has received a command. If an INSTEON controller does not receive this confirmation, it will automatically retransmit the command up to five times.

Further Enhancing Reliability

As signals travel via the powerline or RF throughout the home, they naturally become weaker the farther they travel. The best way to overcome signals getting weaker is to increase the coverage of the mesh network by introducing more INSTEON devices.

It is possible that some audio-video products, computers, power strips or other electrical equipment may attenuate INSTEON signals on the powerline. You can temporarily unplug suspected devices to test whether the INSTEON signal improves. If it does, then you can plug in AC line filters available from Smarthome to permanently fix the problem.

Using Smarthome’s SignaLinc RF to Upgrade Your INSTEON Network

SignaLinc™ RF Signal Enhancers are ideal for improving signal strength and network coverage throughout your home. SignaLinc RF acts like another member of the dual-band mesh network, tying it together by simultaneously retransmitting INSTEON signals across both radio-frequency and the powerline. It also provides an access point for RF-only INSTEON devices, such as handheld controllers.

In addition, two SignaLinc RFs provide a wireless path for INSTEON signals to travel between the two separate electrical circuits, called powerline phases, found in most homes. Without a reliable method for coupling opposite powerline phases, some parts of your home may receive INSTEON signals intermittently. With at least one SignaLinc RF plugged into one of the powerline phases, and at least one more plugged into the opposite powerline phase, INSTEON powerline signals will be strong everywhere in your home.

NOTE

For detailed information and specifications on the Insteon™ technology standard, visit:

http://www.insteon.net
TROUBLESHOOTING

PLC Diagnostics Problems
PLC Diagnostics indicates that the PLC is not connected or is not responding. Double-check that your Port Setting matches the actual port to which your PLC is connected. Make sure that both ends of the connecting (USB or serial) cable are plugged in securely. Re-run the diagnostic. If it fails again, unplug your PLC from AC power, wait 10 seconds, then plug it back in and re-run the diagnostic.

PLC Diagnostics indicates that the PLC Software is not valid. Click the Factory Reset button to reset the PLC and download the correct PLC software.

PLC LED is blinking slowly after being plugged in. This indicates that the programming in the PLC has become corrupted and needs to be re-downloaded. Click the Factory Reset button to reset the PLC and download the correct PLC software.

Linking Problems
Some of my links are displayed in red or brown and indicate ? in the Level % and Rate column in Links. Links that are red or brown are considered orphan or virtual links, meaning that one device's database indicates a link is present but the other device does not indicate it. To fix a virtual or orphan link, simply recreate the link by dragging the appropriate device/button to the Controllers or Responders pane. To remove a virtual or orphan link, right-click the link and choose Delete Link. Once you have fixed or deleted the link, you will need to save your changes to the network.

Some of my links are displayed in gray. Links displayed in gray are deleted links that have not yet been saved to your INSTEON network. From the File menu, choose Save then choose Changes to Network. Once the save is completed the links should disappear from the screen.

Unknown Devices
My device shows up in the Unknown Devices area. Unknown devices are those that could not be contacted through the INSTEON network or that were not discovered successfully. Right-click on the unknown device and choose Re-discover device to re-read its database. If the device is successfully contacted, it will move to the All Known Devices list. If the device remains in the Unknown Devices list, verify that the device is connected and powered. If the device is not part of your installation then it can be deleted.

Device shows ?? in front of its name
My device has ?? in front of its name. Devices prefixed by ?? are considered valid devices but their link databases have not been read. Until their databases have been read, you cannot view or modify their links. Right-click on the device and choose Re-discover device to read its link database.

Timers Not Firing
Sunrise/sunset timers don't work. On the Options tab, verify that your State and City are correct. If not, select them from the drop-down lists and click the Apply button. Verify that your computer's clock is correct; timers are based on your computer's clock. Verify that your computer is running and the HouseLinc Desktop is running. Verify that your computer has not entered suspend mode or hibernate mode.
Events Not Firing

In order for an INSTEON device to transmit a command when its button is pressed, it must be linked as a controller of at least one other device. INSTEON devices when factory reset will not transmit and therefore cannot be used as triggers in events. They can, however, be controlled by direct control, timers, and events. If you wish to trigger an event based on a button press, you should create a link from the trigger button to the PLC (where the PLC is a responder).

Note that EACH button on a KeypadLinc that you want to use as a trigger must have at least one "controller" link to another device. If you wish to trigger an event based on a button press from a KeypadLinc, you should create a link from each button on the KeypadLinc to the PLC (where the PLC is the responder).

Some of my INSTEON Devices are not discovered during spidering

INSTEON devices are only discovered during spidering (File > Open from Network) if they are linked to the PLC or to other INSTEON devices that are in turn linked to the PLC. Devices that have no links to the PLC and are not linked to devices that are linked to the PLC are considered "islands" and need to either be added manually (Network > New > Device) or through the Auto Link process.

I double-clicked HouseLinc but the program doesn't seem to load.

We only allow one instance of HouseLinc to be running on the computer. Windows XP (and later) allow multiple users to be logged in on a computer, each with their own applications running. If HouseLinc doesn't load when you double-click the icon, it's possible that another user already has HouseLinc running which will prevent it from running under your login at the same time.

In Timers and Events, the Results column only shows “n/a”

The results column shows the last time an event or timer was fired. Every time you edit a timer or event, the list of timers and events are rebuilt and the results column is cleared (displaying n/a). Once timers and events begin firing again, the results column will start getting populated again.

Computer won’t shut down

Your computer may not shut down if HouseLinc Desktop is running. If you wish to shut down your computer, please close HouseLinc Desktop first. Please note that timers and events managed by HouseLinc Desktop will no longer function if HouseLinc Desktop is closed and/or your PC is turned off.

Devices are not being recognized when “Auto Linking”

1. Click on the Options tab, then under PLC diagnostics click Start to verify the PLC is connected, then click OK.

2. Click the Factory Reset button (this will download coreapp 12 to the PLC; it will not delete any links already in the PLC).

Timers configured in Other Timer software no longer functioning

If you are using third party software, you should check with the manufacturer of the software to verify the software is compatible with coreapp 12. Although the PLC Factory Reset will not erase links already added, it will clear all timers downloaded to the PLC if you are using Timer Software. You will have to download timers again through Timer Software to restore Timers previously downloaded to the PLC.